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Using the Resource Library

This tab includes resources to help you learn more about Cisco Unified Communications.
System Release Documentation

Solution Reference Network Design

Network Topology Resources

Component Resources

Cisco Unified Communications System Demo
System Compatibility Tool

Ordering Guides

End-of-Sale and End-of-Life Products

Cisco Unified Workspace Licensing
Troubleshooting Individual Components

Documentation Wiki

System Release Documentation

System Description

System Release Notes

System Installation and Upgrade Manual
System Test Results

System Description

System Description for Cisco Unified Communications System, Release 6.1(1)

System Release Notes

System Release Notes for Contact Center: Cisco Unified Communications System, Release 6.1(1)
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System Installation and Upgrade Manual

System Installation and Upgrade Manual for Contact Center: Cisco Unified Communications System,
Release 6.1(1)

System Test Results

This topic summarizes the results of Cisco Unified Communications Release 6.1(1) system testing for
contact center environments. This topic contains the following sections:

e Testing Objectives
e Tested Deployment Models and Sites
e Test Results

Testing Objectives

Cisco Systems validates Cisco Unified Communications systems by designing, installing, configuring,
and testing hardware and software to achieve a predictable, effective, and reliable system. The intent of
system testing is to validate the seamless interoperability and stability of the components that make up
a complete and optimized Cisco Unified Communications system.

Testing performed for Cisco Unified Communications includes (but is not limited to) the following:

e Installation, Upgrade, and Usability Testing—To verify software installation and upgrades at the
system level and usability for system components

¢ End-to-End Functionality Testing—To verify the end-to-end functionality of system components
¢ Basic Functionality and Feature Testing—To verify basic call flows and component features

e Customer Assurance Program (CAP) Scenario Testing—To re-create and test CAP scenarios based
on TAC input

e Interoperability Testing—To verify the interoperability among system components
e Scalability Testing—To verify system functionality during scalability tests

e Performance, Load, and Stress Testing—To verify system functionality during performance, load,
and stress tests

¢ Failover, Recovery, and Redundancy Testing—To verify system behavior during failover and
recovery, and behavior in redundant configurations

Tested Deployment Models and Sites

Several deployment models and sites were designed and tested as part of Cisco Unified Communications
System Release 6.1(1) for Contact Center. For information about the hardware and software
components, configurations, and environment tested and verified for interoperability in this system
release, see Test Deployment Models and Sites.

Test Results

The results of the system tests performed for contact center during Cisco Unified Communications
Release 6.1(1) are shown in the System Test Results.
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Solution Reference Network Design

The test results contain the following information:

e Title—Title of the test.

e ID—Identifier for the test.

e Description—Description of the purpose of the test.

e Features Tested—Component feature tested.

e Status—Result of the test and any defects related to the test case. Possible values are:
— Passed—Test case passed as described in the table.
— Failed—Test case failed and the reason is described in the listed defect.

— Passed with exception—Test case as described passed but an anomaly occurred that was not
directly related to the functionality being tested. Possible anomalies are as follows:

The test steps were modified based on the actual feature implementation.
The test setup was modified based on the actual feature implementation.

The test results did not exactly match what was expected although the feature performed as
required.

e Defects—Identifier for any defect that was opened against the test. If you have an account with
Cisco.com, you can use the Bug Toolkit to view information about defects.

To access the Bug Toolkit, go to this URL:
http://tools.cisco.com/Support/BugToolKit/ (&

Solution Reference Network Design

Solution Reference Network Design (SRND) guides provide considerations and guidelines for
deploying components for the Cisco Unified Communications System. SRND resources are available at
http://www.cisco.com/go/srnd.

Network Topology Resources

This topic provides topology resources you can use to document network plans. Specifically, it includes:
e Microsoft Visio Network Topology Diagrams as individual Microsoft Visio files

¢ How to Use Microsoft Visio Drawings Efficiently for best practices in using Microsoft Visio files

Microsoft Visio Network Topology Diagrams

You can download zip files containing Visio drawings of the logical and physical topologies for the
contact center sites that are documented in Test Deployment Models and Sites. Table 7-1 identifies the
Visio drawings in each zip file.

Note  You need Microsoft Visio 2003 to open the files.

If you need to create new Visio drawings, you can use the Cisco Visio stencils located at the Visio
Stencils resource page.
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Table 7-1 Network Topology Diagrams for Contact Center

Description

Filename

Zip file includes logical and physical drawings in Test
Bed 1 as listed below.

UC611_TB1_Topologies.zip (right-click to download zip) 4.2 MB

Note

If you click the link rather than right-click, the zip file may
open in the secondary window but also replace the contents
of this window. Use your Back button to return to this

window.

Unified IP IVR Sites in Test Bed 1

UC611_IPCC_CCM_Logical_ALL.vsd

Site 1 IP IVR Logical Topology

UC611_IPCC_CCM_Logical_Sitel.vsd

Site 2 IP IVR Logical Topology

UC611_IPCC_CCM_Logical_Site2.vsd

Site 3 IP IVR Logical Topology

UC611_IPCC_CCM_Logical_Site3.vsd

Site 4 IP IVR Logical Topology

UC611_IPCC_CCM_Logical_Site4.vsd

Site 5 IP IVR Logical Topology

UC611_IPCC_CCM_Logical_Site5.vsd

Site 6 IP IVR Logical Topology

UC611_IPCC_CCM_Logical_Site6.vsd

Site 7 IP IVR Logical Topology

UC611_IPCC_CCM_Logical_Site7.vsd

Site 8 IP IVR Logical Topology

UC611_IPCC_CCM_Logical_Site8.vsd

Site 1 IP IVR Physical Topology

UC611_IPCC_CCM_Physical_Sitel.vsd

Site 2 IP IVR Physical Topology

UC611_IPCC_CCM_Physical_Site2.vsd

Site 3 IP IVR Physical Topology

UC611_IPCC_CCM_Physical_Site3.vsd

Site 4 IP IVR Physical Topology

UC611_IPCC_CCM_Physical_Site4.vsd

Site 5 IP IVR Physical Topology

UC611_IPCC_CCM_Physical_Site5.vsd

Site 6 IP IVR Physical Topology

UC611_IPCC_CCM_Physical_Site6.vsd

Site 7 IP IVR Physical Topology

UC611_IPCC_CCM_Physical_Site7.vsd

Site 8 IP IVR Physical Topology

UC611_IPCC_CCM_Physical_Site8.vsd

Zip file includes logical and physical drawings in Test
Bed 2 as listed below.

UC611_TB2_Topologies.zip (right-click to download zip) 3.6 MB

Note

If you click the link rather than right-click, the zip file may
open in the secondary window but also replace the contents
of this window. Use your Back button to return to this

window.

Parent and Child Sites in Test Bed 2

UC611_IPCC_PC_Logical _ALL.vsd

Site 1 Parent and Child Logical Topology

UC611_IPCC_PC_Logical_Sitel.vsd

Site 4 Parent and Child Logical Topology

UC611_IPCC_PC_Logical_Site4.vsd

Site 5 Parent and Child Logical Topology

UC611_IPCC_PC_Logical_Site5.vsd

Site 9 Parent and Child Logical Topology

UC611_IPCC_PC_Logical_Site9.vsd

Site 1 Parent and Child Physical Topology

UC611_IPCC_PC_Physical_Sitel_Parent.vsd

Site 4 Parent and Child Physical Topology

UC611_IPCC_PC_Physical_Site4_Parent.vsd

Site 5 Parent and Child Physical Topology

UC611_IPCC_PC_Physical_Site5_Child.vsd

Site 9 Parent and Child Physical Topology

UC611_IPCC_PC_Physical_Site9_Child.vsd
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Table 7-1 Network Topology Diagrams for Contact Center (continued)

Description Filename

Zip file includes logical and physical drawings in Test |[UC611_TB3_Topologies.zip (right-click to download zip) 7.3 MB

Bed 3 as listed below. Note If you click the link rather than right-click, the zip file may

open in the secondary window but also replace the contents
of this window. Use your Back button to return to this
window.

UC611_IPCC_CVP_Logical_ALL.vsd

Unified CVP Sites in Test Bed 3

Site 1 CVP Logical Topology

UC611_IPCC_CVP_Logical_Sitel.vsd

Site 2 CVP Logical Topology

UC611_IPCC_CVP_Logical_Site2.vsd

Site 3 CVP Logical Topology

UC611_IPCC_CVP_Logical_Site3.vsd

Site 5 CVP Logical Topology

UC611_IPCC_CVP_Logical_Site5.vsd

Site 6 CVP Logical Topology

UC611_IPCC_CVP_Logical_Site6.vsd

Site 7 CVP Logical Topology

UC611_IPCC_CVP_Logical_Site7.vsd

Site 8 CVP Logical Topology

UC611_IPCC_CVP_Logical_Site8.vsd

Site 1 CVP Physical Topology

UC611_IPCC_CVP_Physical_Sitel.vsd

Site 2 CVP Physical Topology

UC611_IPCC_CVP_Physical_Site2.vsd

Site 3 CVP Physical Topology

UC611_IPCC_CVP_Physical_Site3.vsd

Site 5 CVP Physical Topology

UC611_IPCC_CVP_Physical_Site5.vsd

Site 6 CVP Physical Topology

UC611_IPCC_CVP_Physical_Site6.vsd

Site 7 CVP Physical Topology

UC611_IPCC_CVP_Physical_Site7.vsd

Site 8 CVP Physical Topology

UC611_IPCC_CVP_Physical_Site8.vsd

How to Use Microsoft Visio Drawings Efficiently

Microsoft Visio allows you to bring drawings into several applications (for example, Microsoft Word,
PowerPoint). Unfortunately, the default method is to insert the whole “Visio object” into a file. This can
cause problems.

When you copy and paste a Visio drawing into another application, the Visio object includes all the
application data with the drawing. This object information is needed if you want to be able to
double-click the drawing from Word or PowerPoint and have it open in Visio for editing. But pasting as
an object adds many megabytes to the size of your file. With only a few such drawings, a Word document
can bloat from 300 KB to 12 MB, making it troublesome to share among authors or reviewers, and a trial
for partners or customers to download.

Bringing a Visio Drawing into a Document

Unless you really need the live editing capability, avoid unnecessary file bloating by performing the
following steps when you paste:

Step1  In Visio, copy the drawing as you normally do. Tip: Ctrl-C copies the whole drawing.

Cisco Unified Communications System, Release 6.1(1)
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Step2 At the desired location in the destination document, choose Edit > Paste Special. In the Paste Special
dialog box, choose Picture (Windows Metafile).

Paste Special
Source:  Visio 2000 Draving

iE3
C:\Documents and SettingsihwelsertiMy D
:

(%) Paste:
() Paste fink:

Result
Inserts the contents of the Chipboard a5 a wandows

@ metafils picture,

Step3  Click OK. The drawing is inserted as an ordinary picture. If it is not positioned properly, choose Format
> Picture, click the Layout tab and select In line with text.

The Bottom Line
Do not use the paste default (Edit > Paste or Ctrl-V) to paste Visio drawings. Always use Paste Special.
Downsizing Existing Drawings

If a document is larger than it should be, you can check to see if the Visio drawings are the reason and,
if so, fix the problem.

Step 1 With the drawing selected in the Word or PowerPoint document, choose Edit. At the bottom of the Edit
menu, you will see one of the following:

e Edit Object, if the drawing was inserted by simple pasting. It is a Visio object and taking up much
more file space than it needs to. Go on to Step 2.

e Edit Picture, if the drawing was inserted properly, as a picture. It is not the source of the large file
size.

Step2  If the drawing is an object, cut it (Ctrl-X), and then repaste it as in Bringing a Visio Drawing into a
Document.

Tip You can easily click through the document to check each picture by using the Go To feature in Microsoft
Word. Where you want to start searching, press Ctrl-G. In the Go To What list, select Graphic and click
Next. You go to the next graphic. Click it to select and then check as in Step 1. If needed, repaste as in
Step 2. Click Next and continue these steps for other graphics.

Cisco Unified Communications System, Release 6.1(1)
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Component Resources

Component Resources Documentation

Configuration Command Files

Component Resources Documentation

Component Resources Il

Table 7-2 provides links to the main page for documentation on various Cisco Unified Communications
components, from which you can navigate to individual documents. For documentation on specific tasks,
see Component Installation and Configuration Guides on the Implement tab. For documentation on all
other Cisco products, go to http://www.cisco.com/go/techdocs.

Table 7-2

Component Resources Documentation for Contact Center

Category

Component

Documentation URLs

Call Control

Cisco Unified Communications Manager

http://www.cisco.com/en/US/products/sw/voicesw
/ps556/tsd_products_support_series_home.html

Cisco Unified Presence

http://www.cisco.com/en/US/products/ps6837/tsd
_products_support_series_home.html

Contact Center

Cisco Unified Intelligent Contact
Management

http://www.cisco.com/en/US/products/sw/custcos
w/ps1001/tsd_products_support_series_home.htm
1

Cisco Unified Contact Center Enterprise

http://www.cisco.com/en/US/products/sw/custcos
w/ps1844/tsd_products_support_series_home.htm
1

Cisco Support Tools

http://www.cisco.com/en/US/products/ps5905/ind
ex.html

Cisco Customer Response Solutions
(Unified IP IVR)

http://www.cisco.com/en/US/products/sw/custcos
w/ps1846/tsd_products_support_series_home.htm
1

Cisco Unified Customer Voice Portal

http://www.cisco.com/en/US/products/sw/custcos
w/ps1006/tsd_products_support_series_home.htm
1

Computer Telephony Integration Object
Server (CTI OS) and Agent Desktop

http://www.cisco.com/en/US/products/sw/custcos
w/ps14/tsd_products_support_series_home.html

Cisco Agent Desktop (CAD) Server and
Agent Desktop

http://www.cisco.com/en/US/products/sw/custcos
w/ps427/tsd_products_support_series_home.html

Voice Mail and Unified
Messaging

Cisco Unity Connection

http://www.cisco.com/en/US/products/ps6509/tsd
_products_support_series_home.html

End Points and Clients

Cisco IP Communicator

http://www.cisco.com/en/US/products/sw/voicesw
/ps5475/tsd_products_support_series_home.html

Cisco Unified IP Phones

http://www.cisco.com/en/US/products/hw/phones/
ps379/tsd_products_support_series_home.html

Network Management

Cisco Unified Operations Manager

http://www.cisco.com/en/US/products/ps6535/tsd
_products_support_series_home.html
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Table 7-2 Component Resources Documentation for Contact Center (continued)
Category Component Documentation URLs
Security Cisco Catalyst 6500 Series Switch http://www.cisco.com/en/US/products/hw/module

Firewall Services Module (FWSM)

s/ps2706/ps4452/tsd_products_support_model_ho
me.html

Cisco Adaptive Security Appliance
(ASA) 5540 Services

http://www.cisco.com/en/US/products/ps6120/tsd
_products_support_series_home.html

CiscoWorks Management Center for
Cisco Security Agents

http://www.cisco.com/en/US/products/sw/cscowo
rk/ps5212/tsd_products_support_eol_series_home
html

Cisco Security Agent for Unified
Communications Manager

http://www.cisco.com/en/US/products/sw/voicesw
/ps556/tsd_products_support_series_home.html

Cisco Security Agent for Customer
Response Solutions

http://www.cisco.com/en/US/products/sw/custcos
w/ps1846/tsd_products_support_series_home.htm
1

Cisco Security Agent for Unified
Intelligent Contact Management

http://www.cisco.com/en/US/products/sw/custcos
w/ps1001/tsd_products_support_series_home.htm
1

Cisco Security Agent for Unified
Customer Voice Portal

http://www.cisco.com/en/US/products/sw/custcos
w/ps1006/tsd_products_support_series_home.htm
1
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Table 7-2 Component Resources Documentation for Contact Center (continued)
Category Component Documentation URLs
Communications Cisco IOS Software Release 12.4 T http://www.cisco.com/en/US/products/ps6441/tsd
Infrastructure _products_support_series_home.html
Cisco 3725, 3745 (Unified CVP VXML |http://www.cisco.com/en/US/products/hw/routers/
voice/data, H.323, SIP, and MGCP ps282/tsd_products_support_series_home.html
gateways)
Cisco 3825, 3845 (Unified CVP VXML, |http://www.cisco.com/en/US/products/ps5855/tsd
voice/data, H.323, SIP, and MGCP _products_support_series_home.html
gateways)
Cisco AS5400HPX, AS5400XM (Unified |http://www.cisco.com/en/US/products/hw/univgat
CVP VXML voice, H.323, and PSTN e/ps505/tsd_products_support_series_home.html
gateways)
Cisco AS5850 (PSTN and voice gateway) |http://www.cisco.com/en/US/products/hw/univgat
e/ps509/tsd_products_support_series_home.html
Cisco 3745 (gatekeeper) http://www.cisco.com/en/US/products/hw/routers/
ps282/tsd_products_support_series_home.html
RSVP Agent (on 37xx and 38xx http://www.cisco.com/en/US/products/hw/routers/
platforms) ps282/tsd_products_support_series_home.html
Cisco 7206 (core/WAN router) http://www.cisco.com/en/US/products/hw/routers/
ps341/tsd_products_support_series_home.html
Cisco 871 router http://www.cisco.com/en/US/products/hw/routers/
ps380/tsd_products_support_series_home.html
Cisco Catalyst 3750 (access switch) http://www.cisco.com/en/US/products/hw/switche
s/ps5023/tsd_products_support_series_home.html
Cisco Catalyst 6506, 6509 (core switch, |http://www.cisco.com/en/US/products/hw/switche
Supervisor 2) s/ps708/tsd_products_support_series_home.html
Cisco Catalyst 6506, 6509 (MSFC,
Supervisor 2)
Cisco CSS 11501 Content Services http://cisco.com/en/US/products/hw/contnetw/ps7
Switch 92/tsd_products_support_series_home.html
Cisco Communication Media Module http://cisco.com/en/US/products/hw/switches/ps7
(CMM) 08/tsd_products_support_series_home.html
Wireless Cisco Aironet Access Point 1240AG http://www.cisco.com/en/US/products/ps6521/tsd
_products_support_series_home.html

Configuration Command Files

You can download sample configuration files from Table 7-3 for the call flow components described in
Tested Call Flows.

Cisco Unified Communications System, Release 6.1(1)
| g 7o


http://www.cisco.com/en/US/docs/voice_ip_comm/uc_system/UC6.1.1/cc_system_arch/ch4_flow.html
http://www.cisco.com/en/US/products/ps6441/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/routers/ps282/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps5855/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/univgate/ps505/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/univgate/ps509/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/routers/ps282/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/routers/ps282/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/routers/ps341/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/routers/ps380/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/switches/ps5023/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/switches/ps708/tsd_products_support_series_home.html
http://cisco.com/en/US/products/hw/contnetw/ps792/tsd_products_support_series_home.html
http://cisco.com/en/US/products/hw/switches/ps708/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6521/tsd_products_support_series_home.html

Chapter7  Resource Library |

Component Resources

Table 7-3 Sample Call Flow Component Configuration Files

Description

Filename

Test Bed 1 Call Flows: Cisco Unified
Communications Manager Post-Routed Call Flow
Components

CCM_Config.zip (right-click to download
zip) includes the files below.

Note If you click the link rather than
right-click, the zip file may open in
the secondary window but also
replace the contents of this window.
Use your Back button to return to
this window.

Sitel Cisco 3825 Gatekeeper3

cs1-3825-gk3.txt

Sitel Cisco 7206V XR Router

cs1-7206.txt

Sitel Cisco CMM Gateway1

csl-cmm-gw1.txt

Sitel Cisco CMM Gateway?2

csl-cmm-gw2.txt

Sitel Cisco 3845 Conference/Transcoder Bridgel

cs1-3845-ctl.txt

Site2 Cisco 7206VXR Router

¢s2-7206.txt

Site2 Cisco 3845 Conference/Transcoder Bridge2

cs2-3845-ctl.txt

Site3 Cisco 7206 VXR Router

¢s3-7206.txt

Site3 Cisco 3845 Conference/Transcoder Bridge3

cs3-3845-ctl.txt

Site4 Cisco 3745 Gatekeeper3

cs4-3745-gk3.txt

Site4 Cisco AS5400HPX Gateway1

cs4-5400-gw.txt

Site4 Cisco AS5850 Gatewayl

cs4-5850-gw.txt

Site4 Cisco 7206V XR Router

cs4-7206.txt

Site4 Cisco 3845 Conference/Transcoder Bridge4

cs4-3845-ctl.txt

Site5 Cisco 7206 VXR Router

¢s5-7206.txt

Site5 Cisco CMM Gateway 1

csS-cmm-gw 1.txt

Site5 Cisco 3845 Conference/Transcoder Bridge5

cs5-3845-ctl.txt

Site6 Cisco 3745 Gatewayl

cs6-3745-gwl.txt

Site6 Cisco 3745 Gateway?2

cs6-3745-gw2.txt

Site6 Cisco 7206VXR Router

¢s6-7206.txt

Site6 Cisco 3845 Conference/Transcoder Bridge6

cs6-3845-ctl.txt

Test Bed 2 Call Flows: Parent and Child Call Flows

PC_Config.zip (right-click to download
zip) includes the files below.

Note If you click the link rather than
right-click, the zip file may open in
the secondary window but also
replace the contents of this window.
Use your Back button to return to
this window.

Sitel Cisco 3745 Gatekeeperl

pes1-3745-gkl.txt

Sitel Cisco 3745 Gatekeeper2

pcs1-3745-gk2.txt

] Cisco Unified Communications System, Release 6.1(1)
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Table 7-3 Sample Call Flow Component Configuration Files (continued)

Description

Filename

Sitel Cisco 3745 Gateway1

pes1-3745-gwl.txt

Sitel Cisco 7206V XR Router

pcs1-7206.txt

Site4 Cisco 3745 Gatekeeperl

pcs4-3745-gk1 .txt

Site4 Cisco 3745 Gatekeeper2

pes4-3745-gk2.txt

Site4 Cisco 3745 Gateway1

pes4-3745-gwl.txt

Site4 Cisco 7206V XR Router

pcs4-7206.txt

Site9 Cisco 3660 Gatekeeperl

pcs9-3660-gk1.txt

Site9 Cisco 7206VXR Router

pcs9-7206.txt

Site9 Cisco CMM Gateway 1

pcs9-cmm-gw 1 .txt

Test Bed 3 Call Flows: Cisco Unified Customer Voice
Portal Post-Routed Call Flow Components

CVP_Config.zip (right-click to download

zip)
Note

includes the files below.

If you click the link rather than
right-click, the zip file may open in
the secondary window but also
replace the contents of this window.
Use your Back button to return to
this window.

Sitel Cisco 3745 Gatekeeperl

ps1-3745-gkl.txt

Sitel Cisco 3745 Gatekeeper2

ps1-3745-gk2.txt

Sitel Cisco 6509 Switchl

ps1-6509-SW1.txt

Sitel Cisco 7206VXR Router

ps1-7206.txt

Sitel Cisco Content Services Switchl

psl-cssl.txt

Site3 Cisco AS5400HPX Gateway2

ps3-5400-gw2.txt

Site3 Cisco AS5400HPX Gateway3

ps3-5400-gw3.txt

Site3 Cisco 6506 Router

ps3-6506-rtr.txt

Site3 Cisco 6506 Switchl

ps3-6506-SW1.txt

Site5 Cisco 6509 Router

psS-6509-rtr.txt

Site5 Cisco Content Services Switch2

psS-css2.txt

Site6 Cisco AS5400HPX Gateway?2

ps6-5400-gw2.txt

Site6 Cisco AS5400HPX Gateway3

ps6-5400-gw3.txt

Site6 Cisco AS5400HPX Gateway4

ps6-5400-gw4.txt

Site6 Cisco AS5400HPX Gateway5

ps6-5400-gw5.txt

Site6 Cisco PSTN/VXML Gateway?2

ps6-pstn-vxml-gw?2.txt

Site8 Cisco PSTN Gateway1 (with Unified Presence)

ps8-pstn-gw 1-cup.txt

Site8 Cisco 3845 SIP VXML Gateway1 (with Unified
Presence)

ps8-3845-gw1-vxml-cup.txt
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Cisco Unified Communications System Demo

The capabilities of a Cisco Unified Communications solution can be demonstrated using the Demo
Remote [Internal] tool. Demo Remote is a mobile, web-based demonstration platform that allows sales
personnel to demonstrate a wide variety of Cisco solutions in Cisco offices or at customer sites using the
Cisco VPN Client or a small mobile endpoint kit. Demonstrations are scripted, easy to use, and allow
full administrative access during the demonstration session.

The Cisco Unified Communications Demonstration highlights key components and features of the Cisco
Unified Communications solution. The demo offers a full set of business telephony features and a
complete IP-based applications portfolio including voice, unified communications, mobility, presence,
conferencing services and video. The demo is intended for medium to large customers with a need for
integrated voice, video, and unified communications.

System Compatibility Tool

The Cisco Unified Communications Compatibility Tool provides tables that identify the compatible
software release versions for each product element in each Cisco Unified Communications release.

Ordering Guides

Ordering guides for most Cisco Unified Communications products are available for partners and Cisco
employees. For information on ordering guides, go to the following URL:

http://www.cisco.com/web/partners/sell/technology/ipc/announcements/
unified_communications_system_6_launch.html &

Click the “What is available for Partners” tab to view a list of the ordering guides and other marketing
collaterals.

End-of-Sale and End-of-Life Products

The end-of-sale (EOS) date is the last date to order the product through Cisco point-of-sale mechanisms.
The product is no longer for sale. There is also an end-of-life (EOL) process that guides the final business
operations associated with the product life cycle.

The EOL process consists of a series of technical and business milestones and activities that, once
completed, make a product obsolete. Once obsolete, the product is not sold, manufactured, improved,
repaired, maintained, or supported.

For information about recommended replacements, see the comprehensive list of announcements at the
following URL:

http://www.cisco.com/en/US/products/prod_end_of_life.html

For information on specific products, choose a product from the following URL:
http://www.cisco.com/go/techdocs

Then click the End-of-Life and End-of-Sale Products link.

For an overview of the Products and Services EOL policy, see the information at the following URL:

http://www.cisco.com/en/US/products/products_end-of-life_policy.html

Cisco Unified Communications System, Release 6.1(1)
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Cisco Unified Workspace Licensing

Cisco Unified Workspace Licensing is an easy, affordable program for procurement of a broad range of
Cisco Unified Communications applications and services. Unified Workspace Licensing facilitates
consistent deployment of multiple applications to all users in their workspaces and helps organizations
maximize the potential of unified communications.

This program streamlines pricing, licensing, and deployment of Cisco Unified Communications
solutions and enables organizations to implement a media-rich unified communications experience at a
cost-effective user basis.

Troubleshooting Individual Components

For a list of the diagnostic tools and supporting troubleshooting documentation available for most
components in a contact center network, see Contact Center Component Troubleshooting Tools and
Documentation on the Implement tab.

To search for support for a product or to find technical information on products, solutions, and
technologies, go to the following URL:

http://www-tac.cisco.com/Support_Library

Documentation Wiki

The Cisco documentation wiki (DocWiki) contains information on a number of Cisco product-related
topics. Among these is a category for Cisco Unified Communications Systems, which currently includes
topics for:

e Unified Communications System Design: This topics includes information and tutorials on design
tools such as the Cisco Unified Communications Sizing Tool, which can be used to design and model
solutions for existing and prospective customers.

e Unified Communications System Implementation: This topic includes information on installing and
configuring system components, and provides detailed configuration examples based on tested
deployment models.

e Unified Communications System Operations: This topic includes information on the tasks you need
to perform to maintain and optimize your system and keep it operating as trouble-free as possible.
These tasks are broken down into two areas: one-time and infrequent tasks, and regular and
scheduled tasks.

e Unified Communications System Troubleshooting: This topic includes information that will assist
you with isolating and resolving problems you may have with Unified Communications system
components. This topic offers sections for system troubleshooting methodology and commonly
encountered problems.

For additional Cisco Unified Communications topics posted on the Cisco documentation wiki, see
http://docwiki.cisco.com/wiki/Cisco_Unified_Communications.
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